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�
Panzer Campaigns Order Of Battle Editor


Introduction


�xe "Introduction"�


The Panzer Campaigns Order Of Battle Editor is used to create and modify Orders of Battle used in the Panzer Campaigns series of games.  Each Order of Battle is made up of hierarchical organizations from Army Group down to Platoon, with individual units making up the organizations at the lowest level.  Each unit can be assigned individual values such as Strength, Class, Type, and so forth.





This manual last updated: March 12, 2002


Using The Editor


�xe "Using The Editor"�


�By default, when the Order Of Battle Editor is run, it will prompt you for the filename of an existing Order of Battle file.  All Order of Battle files are given the default extension oob.  To create a new Order of Battle, cancel the initial Open dialog.





Orders of Battle are displayed in the Editor using a standard Windows tree control.  The display of organizations can be controlled by clicking on the plus or minus sign next to each organization to expand or collapse the display.  At any given time, either the top level of the display or one particular organization or unit will be selected.  Individual units are displayed with the information specific to them, while organizations are displayed with total information of based on all units in the organization.





�





To start a new Order of Battle, click on the Add button �.  This will display the The Org/Unit Dialog so that new entries can be made in the Order of Battle.





After an entry is made in the Order of Battle, it can be modified by selecting it and clicking on the Edit button �.  This will display either the The Edit Organization Dialog or the Org/Unit Dialog depending on whether the selected entry is an organization or unit.





In general, all operations in the Editor can be performed in one of three ways:


Menu operations


Toolbar buttons


Pop-up menu





�To activate the Pop-up menu, click with the right mouse button anywhere in the display area.





Existing entries in the Order of Battle may be moved using several functions.  To raise an entry in the list of entries in the same organization, select the entry and click on the Raise button �.


To lower an entry in the list of entries in the same organization, select the entry and click on the Lower button �.





Having selected an entry in the Order of Battle, you can delete the entry and all subentries by clicking on the Delete button �.  Deleted data may be copied into another organization by selecting the organization and clicking on the Paste button �.





Data can be copied without deleting it by clicking on the Copy button �.  Then the data can be pasted into an organization in the Order of Battle by selecting the organization and clicking on the Paste button.  For example, to generate a list of three companies in a battalion using the same data, create the first company, copy it, select the battalion, and click on the Paste button for as many times as you wish to duplicate the company in the battalion.  Note that you can copy or delete an entry from one Order of Battle, open another Order of Battle, and Paste what you copied or deleted into that Order of Battle.


The Menus


File Menu


�xe "File Menu"�


�The File Menu is used to read and write Orders of Battle to files.�Select New to start a new Order of Battle.�Select Open to open an existing Order of Battle.  You will be prompted for the filename.�Select Save to save the current Order of Battle.  If the Order of Battle has not already been saved, you will be prompted for a filename.�Select Save As to save the current Order of Battle in a different file.  You will be prompted for the new filename.�Select Save All to save all unit information in the current Order of Battle to the unit database.


Select Print to print the entire Order of Battle to a text file.  You will be prompted for the name of the file.�Select Fix Indexing Errors to fix any problems with internal indexing in the OB file.  Under normal circumstances, this is never necessary.  However, if you attempt to manually edit the Order of Battle file, it is easy for indexing problems to occur.  Using this feature will fix the file so you can continue using it.


Select Exit to exit the Order of Battle Editor program.


Components Menu


�xe "Components Menu"�


�The Components Menu is used to make global changes to Components and their values.  See the Org/Unit Dialog for an explanation of Components and their values.�Select Change Name to display the Change Name Dialog that will allow you to change the name of a Component.  This change will affect all such units in the current Order of Battle as well as the unit database file for that Component.�Select Update Values to have all Component values in the Order of Battle modified to be equal to those saved in the unit database files.  This is used most often when you change the value of an existing Component and wish that change to affect all units with that Component in the Order of Battle.  The update does not affect existing Strength and Quality values in the Order of Battle.�Select Update Unit Values to update only the non-strength values of units that have the same Component as the selected unit.�Select Update Strength to have all Component strength values in the Order of Battle modified to be equal to those saved in the unit database files.�Select Update Unit Strength to update only the strength value of units that have the same Component as the selected unit.





Data Menu


�xe "Data Menu"�


�The Data Menu is used to create and modify the Order of Battle data.�Select Add to add an entry under the current selected organization.  The new entry will be added to the end of the list of existing entries in that organization.�Select Edit to modify the data associated with the currently selected entry.�Select Delete to delete an entry and any subentries of that entry.  After deletion, an entry may be pasted back into the Order of Battle at another location.�Select Copy to copy the currently selected entry and any subentries.  After copying, the data may be pasted back into the Order of Battle at another location.�Select Paste to paste any deleted or copied data into the Order of Battle as a subentry of the currently selected organization.  Note that you can copy or delete data from one Order of Battle and Paste it into another Order of Battle.�Select Raise to raise the currently selected entry with respect to other entries in the same organization.�Select Lower to lower the currently selected entry with respect to other entries in the same organization.�Select Find to find a string in the data.  Note that this search is case-sensitive.�Select Find Next to find the next occurrence of a string in the data.


Help Menu


�xe "Help Menu"�


�The Help Menu is used to display help and other information about the Editor.�Select Contents to display the contents window of this help file.�Select About to display various information about the Editor such as version.


The Dialogs


Org/Unit Dialog





The Org/Unit Dialog is used to add new organizations and units to the Order of Battle and to make changes to existing units.





�


The Org/Unit Dialog�xe "Org/Unit Dialog"� by default is used to add a new organization to the Order of Battle.  An organization has a Nation, Category, and Name.  Lower-level organizations are automatically assigned the nation of their parent organization, but this can be changed provided the selected nation is from the same side, Axis or Allied, of the parent.  The organization category can be anything from Army Group to Platoon with the special categories of Kampfgruppe, Combat Command, and Task Force.  In general, a suborganization must have a small Category than its parent organization.  That is, a Corps may not contain an Army or other Corps.





�


When the Is Unit checkbox is selected, unit information may be specified.  A Unit differs from an Organization in that a Unit may not have sub-organizations.  The Strength of the unit is in terms of men, if the unit is that of Infantry, HQ, Engineer, Cavalry, Machine Gun, or Foot Recon, and in terms of guns or vehicles for all other units.  The Speed of the unit is in terms of Kilometers Per Hour for the nominal road speed of the unit.  The Range values are all in units of Kilometers.  Except for HQ units, if a unit has no attack value of a certain type, for example no Anti-Air Attack value, then the value of the corresponding range value does not matter.  For HQ units, the Soft Range of the unit represents its Command Radius.  It is also possible to specify a Minimum Range for a unit.  This is done by specifying a range value of the form max/min where max is the normal maximum range of the unit and min is the minimum range of the unit.  For example, specifying a range of 6/2 means that the unit has a maximum range of 6 and cannot fire at a target less than 2 km away.





The Component field is used to enter a short description of the primary weapon type or other description of the make-up of the unit.  For example, the Component value might be T-34, Panther, Rifle, 75mm AT, or some other short description.  Selecting the drop-down list associated with this field displays a list of pre-defined units for the current nationality.  Selecting from the drop-down list will copy the Component name into the field, and also copy in default values for the various combat values.  If you make changes to the combat values, change the name of the Component, or enter a new unit with a new Component name, then you can save this information by clicking on the Save button.  This will make the information available for use in defining other units of the current nationality.  In addition, units defined with the previous Component values can be updated using the Update menu item of the File Menu.





For the Nation XXX, Component information is stored in the file XXX/Units.dat.  Furthermore, a picture of the Component YYY should appear in the file XXX/Units/YYY.bmp.





Certain capabilities may be given to units.  They are:


Indirect Fire – unit is capable of firing using indirect fire.  That is, the unit may fire at enemy units it cannot see itself.


Mine Clearing – unit is capable of clearing mine fields.  This includes Engineer units but also units such as flail tanks.


Amphibious – unit is capable of moving through water.


Paradrop – unit is capable of being dropped by parachute or glider.  Depending on their training, this may or may not apply to all Parachute units.


Bridge Eng – unit can build bridges.  This type of unit has the training and equipment to build bridges.


Single Use – unit is only available in the game for a single player turn or, for aircraft, for a single air strike. Single Use ground units are automatically removed from the game after a single turn, while Single Use aircraft become Unavailable after they have been used in an air strike.  Typically used with units such as Rocket Ships and Strategic Bombers.


Jet Aircraft – you only assign this attribute to aircraft units to indicate that they are jet aircraft as opposed to the default propeller aircraft.


Night Flying – assigned to aircraft units to indicate that the unit is capable of flying at night.


Deception Unit – unit is designed to be used to cause deception among enemy units.





After you have made all selections for the new organization or unit, select OK.  Selecting Cancel will cancel the current operation and make no changes to the Order of Battle.


Edit Organization Dialog





The Edit Organization Dialog is used to edit an existing organization.





�


The Edit Organization Dialog�xe "Edit Organization Dialog"� allows the nation, name, and category of the organization to be modified.  The nation of an organization must be on the same side, Axis or Allied, of its parent organization.  The category of an organization must be between the category of its parent and the highest category of its suborganizations.


Other Features


Toolbar


�xe "Toolbar"�


The Toolbar provides an easy way of performing most tasks in the Editor.





�New – start a new Order of Battle.


�Open – open an existing Order of Battle.


�Save – save the current Order of Battle to a file.





�Add – add a new Order of Battle entry either as a top level entry or as a subentry of the selected entry.


�Edit – modify the currently selected Order of Battle entry.


�Delete – delete the currently selected Order of Battle entry and any subentries.


�Copy – make a copy of the currently selected Order of Battle entry.


�Paste – paste a copied or deleted Order of Battle entry as a subentry of the currently selected entry.


�Raise – move the currently selected Order of Battle entry up with respect to other entries in the same organization.


�Lower – move the currently selected Order of Battle entry down with respect to other entries in the same organization.


�Find – find a string in the data.  Note: this search is case sensitive.


�Next – find next occurrence of string in data.


�Help – display this help file.


�
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